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SKILL SUMMARY

Skills Exam Objective Objective Number

Creating a Custom Table Create a table.

Con�gure �elds to auto-increment.

2.1.1

2.4.6

Summarizing Table Data Add total rows. 2.2.2

CREATING A CUSTOM TABLE 

When a table template doesn’t suit your needs, you can create a custom table in Design view. In 
Design view, you can insert �elds, set data types, and perform other advanced table design tasks.

Creating a Custom Table

Creating a table from scratch in Design view gives you maximum !exibility. You can do every-
thing you need to do to create the table in Design view, including adding �elds, setting data types, 
de�ning �eld properties, and de�ning a primary key. As you create a table, you can also easily 
insert and delete rows in your table design. In this exercise, you create a new blank table and then 
add �elds for the new table in Design view.

Creating a new �eld for a table in Design view includes typing the name in the Field Name col-
umn; choosing a data type from the menu in the Data Type column; and typing a description, if 
you want, in the Description column. Additionally, you can modify �eld properties in the Field 
Properties section of the design grid.

After you have completed your table design, you’ll need to save it. If you haven’t already de�ned a 
primary key, Access will prompt you to do so when you save the table.

STEP BY STEP Create a Custom Table in Design View 

GET READY. Before you begin these steps, make sure that your computer is on. Sign on, if 

necessary, and start Access.

1. OPEN Lucerne Publishing from the data !les for this lesson and then SAVE the 

database as Lucerne Publishing-!nal.

2. On the Create tab, in the Tables group, click the Table Design button. A new blank table 

is created in Design view, as shown in Figure 9-1.
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New blank table Field Name column Data Type column Description column

Row selector Field Properties section Displays information about the 
location of the insertion point

3. Type ID in the Field Name column.

4. Press the Tab key to move to the Data Type column.

5. Click the down arrow in the Data Type column and then select AutoNumber from the 

menu. The AutoNumber data type will automatically number your records starting at 1.

6. Press the Tab key to move to the Description !eld.

7. Type Record Number and then press Tab again to move to the next blank !eld row.

8. Type Gross Sales and then press the Tab key.

9. Click the down arrow on the Data Type column and then select Currency from the 

menu.

10. Click in the Decimal Places row in the Field Properties section. Click the down arrow 

and then select 0 from the menu.

11. Enter the remaining !elds, as shown in Figure 9-2, formatting each with the Currency 

data type and 0 decimal places.

Figure 9-1

Blank table in Design view
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0 decimal places  Down arrow

12. Click the row selector to the left of the ID �eld to select the row.

13. On the Design tab, in the Tools group, click the Primary Key button.

14. Click the Save button on the Quick Access Toolbar. The Save As dialog box appears.

15. Type Sales and then click OK.

PAUSE. LEAVE the database and Sales table open to use in the next exercise.

Inserting and Deleting Rows

When creating a custom table in Design view, you can insert and delete rows as needed using the 
Insert Rows and Delete Rows commands in the Tools group on the Table Tools Design contextual 
tab. When you click the Insert Rows button, a new row is inserted above the selected row. �e �eld 
order from top to bottom in Design view will be displayed from left to right in Datasheet view. In 
this exercise, you insert and delete rows using the new table you created in the previous exercise.

STEP BY STEP Insert and Delete Rows in Design View

GET READY. USE the Lucerne Publishing-�nal database and the Sales table that are open 

from the previous exercise.

1. Click the row selector to the left of the Gross Sales �eld to select the entire row.

2. In the Tools group on the Table Tools Design contextual tab, click the Delete Rows 

button. The �eld row is deleted from the table.

3. Click the Undo button on the Quick Access Toolbar. The �eld row reappears.

4. In the Tools group on the Table Tools Design contextual tab, click the Insert Rows 

button. A blank row is inserted above the Gross Sales �eld.

5. In the Field Name column, type Area and then press the Tab key.

6. Press the Tab key again to accept the Short Text data type.

7. Leave the Description �eld blank and then press Tab again to move to the next �eld.

8. Click the Save button on the Quick Access Toolbar.

Figure 9-2

Custom Table in Design view
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9. Change to Datasheet view and enter the records shown in Figure 9-3 in the table. The 

ID �eld will be automatically generated, so just press Tab to get past it. 

10. SAVE and CLOSE the table.

PAUSE. LEAVE the database open to use in the next exercise.

USING THE TABLE ANALYZER 

�e Table Analyzer is a wizard that performs the normalization process for you by examining a 
table design and suggesting a way to divide the table for maximum e!ciency. �e Table Analyzer 
helps you design e!cient tables. �e Table Analyzer will suggest primary keys for the new tables 
or will allow you to determine the primary keys. You can also have the wizard insert a unique 
identi"er "eld. If it determines that a table has duplicate information, it can split a table into two 
more e!cient tables for you, or you can choose to do it yourself. 

Using the Table Analyzer

�e Table Analyzer is a wizard that examines a table and asks you a series of questions about the 
table to determine whether it should be divided into two or more tables. In this exercise, you use 
the Table Analyzer Wizard to analyze a table in the database.

Well-designed databases do not store the same data in more than one place. Redundant data stor-
age takes more disk space and increases the likelihood for data entry errors. In Lesson 1, you were 
introduced to the concept of normalization, which is the process of applying rules to a database 
design to ensure that you have divided your data into the appropriate tables.

In the Books table, contact information for authors has to be entered for each book the author 
wrote. �e Table Analyzer Wizard will determine that a more e!cient database would split the 
table into two tables: one with author contact information and one with book sales data.

In addition to analyzing the table, the Table Analyzer Wizard will also analyze the redundant data 
in a table and suggest corrections for records that should match. It will also give you the choice of 
whether to create a query, which is similar to the original table. Creating the query allows forms 
and reports that were created with the original table to continue to function properly. �e original 
table may be renamed, but it will not be removed or altered.

Troubleshooting If you run the Table Analyzer before entering records in the table, you may get a message 
stating that you need to enter at least two records in the table to get a meaningful analysis.

Figure 9-3

Sales table
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STEP BY STEP Use the Table Analyzer

GET READY. USE the Lucerne Publishing-�nal database that is open from the previous 

exercise.

1. Double-click the Books table in the Navigation Pane to open it.

2. Scroll through the table to become familiar with the !elds in the table. 

3. On the Database Tools tab, in the Analyze group, click the Analyze Table button. The 

Table Analyzer Wizard dialog box, screen 1, appears. This !rst dialog box provides 

more information about the types of problems the wizard will !nd. Click the two Show 

me an example buttons to read more about how duplicating information can lead to 

problems. 

4. Click the Next button. The Table Analyzer Wizard dialog box, screen 2, appears. This 

dialog box provides more information about what the wizard will do. Click the two 

Show me an example buttons to read more about how splitting the table is helpful.

5. Click the Next button. The Table Analyzer Wizard dialog box, screen 3, appears, as 

shown in Figure 9-4.

6. The Books table should be selected in the list; if it is not, select it. Click the Next button. 

The Table Analyzer Wizard dialog box, screen 4, appears.

7. The Yes, let the wizard decide button should be selected; if it is not, select it. Click the 

Next button. The Table Analyzer Wizard dialog box, screen 5, appears.

8. Scroll through each table. Notice that the Table2 box contains the Year, which should 

be in Table1 with the sales information. Click the Year !eld to select it. 

9. Drag the selected !eld to the Table1 box, positioning the horizontal black line below the 

Book Title !eld, as shown in Figure 9-5, and releasing the mouse button to place the 

Year !eld in its new location.

Figure 9-4

Table Analyzer Wizard, 
screen 3
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New location

Table names Rename Table button Tips button

 

10. Click the Table1 name to select it. Click the Rename Table button. If you receive a 

message stating that an expression you entered is the wrong data type for one of the 

arguments, click OK. The Table Analyzer Wizard dialog box appears.

Take Note You can also double click on the table name to rename it. 

11. Type Book Sales and then click OK.

12. Click the Table2 name and then click the Rename Table button. If you receive a 

message stating that an expression you entered is the wrong data type for one of the 

arguments, click OK. The Table Analyzer Wizard dialog box appears.

13. Type Author Contact Information and then click OK.

14. Scroll down to the bottom of the Book Sales table. Notice that the Lookup to Author 

Contact Information !eld was added.

15. Scroll through the Author Contact Information table. Notice that the Generated Unique 

ID !eld was added as a primary key. Click the Next button. The Table Analyzer Wizard 

dialog box, screen 6, appears, as shown in Figure 9-6.

Set Unique Identi!er button

16. Click the ID !eld in the Book Sales table to select it. Click the Set Unique Identi!er 

button. A primary key is inserted.

Figure 9-5

Table Analyzer Wizard, 
screen 5

Figure 9-6

Table Analyzer Wizard, 
screen 6



Lesson 9170

17. Click Next. The Table Analyzer Wizard dialog box, screen 7, appears, as shown in Figure 

9-7.

18. Notice that the Table Analyzer Wizard has detected two similar records, one with an 

incorrect zip code and phone number. Click the down arrow in the !rst row of the 

Correction !eld and then select Leave as is. This is the correct record.

19. Click the down arrow on the second row of the Correction !eld and then select the 

Tomic correction from the menu, as shown in Figure 9-8, to replace the incorrect 

record. Click to select it.

20. Click Next. The !nal Table Analyzer Wizard dialog box appears.

21. The Yes, create the query option button should be selected. Click the Finish button.

22. A message saying that the wizard couldn’t rename your table because it’s open and the 

new query will be saved as Books_NEW appears. Click OK.

23. If Access Help appears on your screen, close it. Your screen should look similar to 

Figure 9-9.

24. SAVE and CLOSE all tables and queries.

PAUSE. LEAVE the database open to use in the next exercise.

Figure 9-7

Table Analyzer Wizard, 
screen 7

Figure 9-8

Corrections to the new tables
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SUMMARIZING TABLE DATA 

It is often necessary to count or summarize data in a table, column by column. Tables that contain 
columns of sales �gures or other numbers need to be summed, averaged, or counted to be more 
useful. �e Total row makes these tasks easy. 

Summarizing Table Data

Much like the bottom row of a spreadsheet, the Total row is a feature in Access 2016 that makes 
it easy to sum, average, or count the values in a datasheet column. You can also �nd maximum 
or minimum values and use statistical functions such as standard deviation and variance. In this 
exercise, you summarize table data by inserting a Total row.

Aggregate functions are functions that calculate values across a range of data, such as in a 
column. You can use these functions in queries or in Visual Basic for Applications (VBA) code. 
Although you can still use those methods, the Total row saves you time by allowing you to choose 
one of these functions from a menu, applying it instantly. �e Total row is a row inserted at the 
bottom of a table that provides a menu of functions for each column in the row.

Take Note You can also add a Total row to queries open in Datasheet view and to a split form open in Form 
view. You cannot add a Total row to a report, but you can use aggregate functions in reports using 
other methods.

Table 9-1 describes the aggregate functions available in the Total row and the data types that they 
work with.

Figure 9-9

New tables and queries 
created by the Table Analyzer 
Wizard
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Aggregate 

Function

Description Data Types

Average Calculates the average value for a column Number, Decimal, Currency, Date/Time

Count Counts the number of items in a column All (except multivalued list)

Maximum Returns the item with the highest value Number, Decimal, Currency, Date/Time

Minimum Returns the item with the lowest value Number, Decimal, Currency, Date/Time

Standard 

Deviation

Measures how widely values are dispersed 

from an average value

Number, Decimal, Currency

Sum Adds items in a column Number, Decimal, Currency

Variance Measures the statistical variance of all 

values in the column

Number, Decimal, Currency

As shown in the table, some functions only work with certain data types. For example, you cannot 
sum a column of text, so that function would not be available for a column with the Short Text 
or Long Text data type.

STEP BY STEP Insert a Total Row

GET READY. USE the Lucerne Publishing-�nal database that is open from the previous 

exercise.

1. Double-click the Book Sales table in the Navigation Pane to open it.

2. On the Home tab, in the Records group, click the Totals button. The Total row appears 

below the row with the asterisk (*) in the record selector box. 

3. Click the down arrow in the Book Title column of the Total row. Select Count from 

the menu. The number of records in the column is counted, and the number 11 is 

displayed.

4. Click the down arrow in the Domestic Sales column of the Total row and then select 

Sum from the menu, as shown in Figure 9-10. Click Sum to apply it.

5. Click the down arrow in the International Sales column of the Total row and then select 

Sum from the menu. 

6. SAVE the table.

7. On the Home tab, in the Records group, click the Totals button. The Total row is hidden.

8. On the Home tab, in the Records group, click the Totals button again. The Total row 

reappears.

Table 9-1 

Aggregate functions in the 
Total row
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Total row   Available functions for column

9. SAVE and CLOSE the table.

 STOP. CLOSE the database and then EXIT Access.

Take Note If you want to sort or �lter data, Access will exclude the Total row by default.

Figure 9-10

Total row
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Knowledge Assessment

Matching

Match the term in Column 1 to its description in Column 2.

Column 1 Column 2

1. Aggregate function a.  The process of applying rules to a database design to ensure 

that you have divided your information into the appropriate 

tables 

2. Table Analyzer b.  An optional part of Design view where you can enter a !eld 

description 

3. Normalization  c. An aggregate function that counts the records in a column 

4. Count  d.  A wizard that performs the normalization process by 

examining a table design and suggesting a way to divide the 

table for maximum ef!ciency 

5. Description e. Function that calculates values across a range of data 

True/False

Circle T if the statement is true or F if the statement is false.

T F 1. If you haven’t already de!ned a primary key, Access will prompt you to do so 

when you save the table in Design view.

T F 2. The row selector is located at the bottom of the table.

T F 3. The Table Analyzer does not remove the original table.

T F 4. The Table Analyzer gives you the choice of whether to create a query.

T F 5. You cannot delete a Total row, but you can hide it.

Projects

Project 9-1: Creating and Analyzing Tables

In this project, sales data for Fourth Co�ee has just come in for the �rst quarter. �e manager 
asks you to create a table that displays the sales for each of the �ve stores in your division. Note 
that each store is known by a three-digit number, such as 656. You also decide to use the Table 
Analyzer to check a table you created previously to make sure it is e�cient.

GET READY. LAUNCH Access if it is not already running.

1. OPEN FourthCoffeeInventory from the data !les for this lesson, and then SAVE the 

database as FourthCoffeeInventory-!nal.

2. CREATE a new table in Design view using the Table Design button on the Create tab.

3. Type ID as the !rst !eld name and then press the Tab key. Set the data type to 

AutoNumber.

4. Type Sales Month as the second !eld name and then press the Tab key. Keep the 

default data type.

5. Enter the remaining !eld names and data types, as shown in Figure 9-11. Set the 

primary key as shown.
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6. SAVE the table as Monthly Sales by Store.

7. Change to Datasheet view.

8. Enter the data as shown in the following table.

ID Sales Month Store Sales

1 January 651 $88,432.00

2 February 651 $97,798.00

3 March 651 $67,890.00

4 April 651 $59,098.00

5 January 656 $105,890.00

6 February 656 $96,789.00

7 March 656 $96,789.00

8 April 656 $87,890.00

9 January 660 $106,098.00

10 February 660 $77,998.00

11 March 660 $94,927.00

12 April 660 $84,123.00

13 January 662 $90,890.00

14 February 662 $67,223.00

15 March 662 $87,010.00

16 April 662 $74,280.00 

9. Insert a Total row.

10. Count the Sales Month !eld and sum the Sales !eld.

11. SAVE and CLOSE the table.

12. Double-click the Customers table in the Navigation Pane to analyze it.

13. On the Database Tools tab, in the Analyze group, click the Analyze Table button. The 

Table Analyzer Wizard dialog box appears.

14. Click Next to display the next Table Analyzer Wizard dialog box.

15. Click Next to display the next Table Analyzer Wizard dialog box.

16. The Customers table should be selected. Click Next.

17. The Yes, let the Wizard decide option button should be selected. Click Next.

18. A message is displayed that says the wizard does not recommend dividing the table. 

Click OK.

19. Click Cancel to close the Table Analyzer Wizard.

20. CLOSE the table and the database.

PAUSE. LEAVE Access open for use in the next project.

Figure 9-11

Monthly Sales by Store in 
Design view
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Project 9-2: Creating and Designing a Table

�e owner of Wingtip Toys has given you yearly sales data for each of the company’s sales chan-
nels. In this project, you will create and design a table in which to store and total the data.

GET READY. LAUNCH Access if it is not already running.

1. OPEN WingtipToysInventory from the data !les for this lesson, and then SAVE the 

database as WingtipToysInventory- nal.

2. CREATE a new table in Design view using the Table Design button on the Create tab.

3. CREATE the table as shown in Figure 9-12.

 

4. SAVE the table as Yearly Sales and then change to Datasheet view to review the table 

you just created.

5. Change back to Design view.

6. Insert a blank row above the Catalog Sales !eld.

7. Type Yr as a new !eld with the Short Text data type.

8. Select the Yr !eld and then click the Primary Key button to designate the Year !eld as 

the new primary key.

9. Delete the ID !eld.

10. SAVE the table and then change to Datasheet view.

11. Enter data as shown in the following table.

Yr Catalog Sales Internet Sales Store Sales Other Sales

2014 $87,987.00 $109,897.00 $208,767.00 $23,987.00

2015 $57,984.00 $98,789.00 $197,098.00 $10,761.00

2016 $61,089.00 $78,907.00 $168,234.00 $9,125.00 

12. SAVE the table.

13. Insert a Total row.

14. Sum the Catalog Sales, Internet Sales, Store Sales, and Other Sales columns.

15. SAVE and CLOSE the table.

CLOSE the database and then EXIT Access.  

Figure 9-12

Yearly Sales table in Design 
view


